


Certification Prep Series 
by D. Michael Ploor
Certification Prep Series consists of individual guides that provide practice in the 
basic skills needed to be successful using the corresponding software. No previous 
software experience is required. Although the guides focus on learning skills, not 
test taking, users that complete the practice will be prepared to take the official 
software certification exam and exhibit workplace readiness. Step-by-step instructions 
demonstrate actual software commands and features, building from basic to advanced. 
Content is divided into small units for better learning and usage. There is no need to 
purchase additional materials as all lesson content is created using the software.

 Provides an affordable way to prepare for industry certification versus other methods.
 Integrates easily into existing classroom activities.
 Focuses on hands-on experience to develop skills.

Sample Pages

To learn more, please contact your G-W Educational Consultant, 
visit www.g-w.com, or call 800.323.0440.

Start on Monday.
Test on Friday.

Microsoft Office Products
 Microsoft Word 2016

 Microsoft Excel 2016

 Microsoft PowerPoint 2016

 Microsoft Outlook 2016

 Microsoft Access 2016

 Microsoft Word 2013

 Microsoft Excel 2013

 Microsoft PowerPoint 2013

 Microsoft Outlook 2013

 Microsoft Access 2013

Microsoft Office 2010 is also available.

Adobe Products
 Adobe Photoshop Creative Cloud

 Adobe Dreamweaver Creative Cloud

 Adobe Flash Creative Cloud

 Adobe Illustrator Creative Cloud

 Adobe InDesign Creative Cloud

 Adobe Photoshop CS6

 Adobe Dreamweaver CS6

 Adobe Flash CS6

 Adobe Photoshop CS5

 Adobe Dreamweaver CS5

 Adobe Flash CS5
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Introduction
The Common Occupational Readiness Essentials (CORE) series of certification 
preparation guides focuses on mastering the essential basic skills needed as 
a workplace-ready user of the software. The goal of each CORE certification 
preparation guide is to provide practice in each essential basic skill required by 
employers who use the software. To prove workplace readiness, you will also be 
prepared to take the official certification exam for the software.

CORE Microsoft Excel 2016 will help prepare you to take the Microsoft Office 
Specialist (MOS) Microsoft Excel 2016 certification exam. It provides step-by-step 
instruction for the features and commands covered on the certification exam. The focus 
of the lessons is to practice using the actual commands and features instead of creating a 
complete end product. Additionally, all lesson content is created using the software. The 
only files that need to be downloaded are for the certification simulation at the end of 
this guide. Furthermore, each certification preparation guide is broken down into small 
learning units to enable better comprehension and application of the software. Where 
required, answers are provided at the back of the certification preparation guide.

Certification as a Microsoft Office Specialist demonstrates an aptitude with 
Microsoft Office software. MOS certification is offered for Microsoft Word, 
Microsoft Excel, Microsoft PowerPoint, Microsoft Outlook, Microsoft Access, 
Microsoft SharePoint, and Microsoft OneNote. Certification exams are provided by 
Certiport, Inc., through various testing facilities. Visit www.certiport.com for more 
information on registering for certification exams.

About the Author
D. Michael Ploor is the author of the CORE series of certification preparation guides. 
Mr. Ploor’s students have achieved exceptional results with the CORE certification 
preparation guides. His students collectively pass more than 500 industry certification 
exams each year without the need for other preparation materials. Mr. Ploor has 
demonstrated the strength of integrating the CORE guides in a diverse mix of courses.

Mr. Ploor is also the author of three textbooks on the subject of video game 
design: Introduction to Video Game Design, Video Game Design Foundations, and 
Video Game Design Composition. He is a National Board Certified Teacher in Career 
and Technical Education and holds an MBA degree from the University of South 
Florida. He maintains professional teaching credentials in Business Education and 
Education Media Specialist.

Mr. Ploor is at the forefront of innovative teaching and curriculum. He developed 
STEM curriculum while serving as the lead teacher in the Career Academy of 
Computer Game Design at Middleton Magnet STEM High School. Mr. Ploor 
has applied his skills as a STEM Curriculum Integration Specialist in designing 
innovative curriculum and by collaborating to construct the state standards for 
video game design in several states. He has also been instrumental in authoring 
competitive events for Career and Technical Student Organizations such as the 
Future Business Leaders of America (FBLA) and Phi Beta Lambda (PBL). 

In addition to publishing textbooks and lessons, Mr. Ploor provides professional 
development as a frequent presenter at regional and national conferences to 
promote CTE education and video game design curriculum.
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Lesson 3 
Getting Acquainted

Objectives
Students will enter data into a spreadsheet. Students will use the auto fill feature to 
populate cells with data. Students will set the data type for cells. Students will set 
the column width. Students will add borders to cells. Students will enter formulas 
into cells. Students will sort data. Students will work with various views in Excel. 
Students will print a workbook.

How to Begin
 1. Launch Microsoft Excel 2016.

 2. Applying what you have learned, start a new blank document and display the 
normal page view.

 3. Save the workbook as LastName_Excel Basics in your working folder.

Entering Data
 4. With cell A1 active (selected), enter the text Microsoft Excel Worksheet. Notice the 

text is wider than the cell, but is visible. This is because the cell alignment is not 
set to wrap text. If data are entered into cell B1 or C1, part of the text in cell A1 
will be obscured.

 5. Click cell A2 to select it, and enter the text Fill Exercise.

 6. In cell A4, enter the text Monday.

 7. In cell A5, enter the text Tuesday.

 8. In cell B4, enter the number 1.

 9. In cell B5, enter the number 2.

 10. In cell C4, enter the number 5.

 11. In cell C5, enter the number 10.

 12. In cell D4, enter the number 11.

 13. In cell D5, enter the number 56.

Using Auto Fill
A selection consisting of more than one cell is called a range. Ranges are used 
quite frequently in Excel, whether it is applying formatting to a range or selecting a 
range of data for use in a chart. Additionally, Excel has a feature called auto fill that 
allows additional cells to be filled with data based on the pattern in a selected range.

 14. Select cells A4 and A5 by clicking cell A4, holding the left mouse button, and 
dragging to cell A5. This range is referred to as A4:A5. Notice the green rectangle 
around the selected area to indicate the cells composing the range.

TIP
The arrow and 
[Tab] keys and 
the [Shift][Tab] 
key combination 
can be used to 
quickly navigate a 
worksheet. 

TIP
A range can be 
selected by holding 
down the [Shift] 
key and using 
the arrow keys to 
navigate.
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 15. Click and hold the small green block at the 
bottom-right corner of the range, which is 
the auto fill block, drag down to cell A26, and 
release, as shown in Figure 3-1.

 16. Examine the pattern of data automatically filled 
in for the new range. What is the pattern that 
was created?

 _________________________________________________

 _________________________________________________

 _________________________________________________

 17. Select the range B4:B5.

 18. Double-click the auto fill block. The cells down 
to cell B26 are automatically filled in with the 
pattern of data. This is possible because the 
column next to the selected range has cells 
containing data. If the column were empty, 
the auto fill block would need to be manually 
dragged down to complete the pattern of 
data. This function works vertically, but not 
horizontally. 

 19. What value is in cell B23?

 _________________________________________________

 20. Select the range C4:C5.

 21. Applying what you have learned, complete the 
pattern down to cell C26.

 22. What is the value in cell C14?

 ___________________________________________________________________________________

 23. In which cell does the number 100 appear?

 ___________________________________________________________________________________

 24. What is the pattern of data in column C?

 ___________________________________________________________________________________ 

 ___________________________________________________________________________________

 25. Select the range D4:D5.

 26. Applying what you have learned, complete the pattern down to cell D26.

 27. What is the last value shown in column D?

 ___________________________________________________________________________________

 28. Select the range B4:D4.

 29. Applying what you have learned, complete the pattern in the row to cell H4.

 30. What is the value in cell H4?

 ___________________________________________________________________________________

 31. Select the range B5:D5.

 32. Applying what you have learned, complete the pattern in the row to cell H5.

Drag the auto fill
block to fill cells

Figure 3-1.

Using auto fill to repeat a pattern of data in additional 
cells.
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 33. What is the value in cell H5?

 ___________________________________________________________________________________

Setting the Data Type
 34. Select the range B4:B26.

 35. Click the drop-down arrow next to the Accounting Number Format button on 
the ribbon (Home tab>Number group), and click $ English (United States) in the 
drop-down menu. The data type is set to currency, and the values are displayed 
as dollars and cents.

 36. What is the value displayed in cell B15?

 ___________________________________________________________________________________

 37. Select the range C4:C26.

 38. Click the Percent Style button on the ribbon (Home tab>Number group). The 
data type is set to percentage, and the values are displayed as percentages by 
multiplying by 100.

 39. What is the value in cell C24?

 ___________________________________________________________________________________

 40. Select the range D4:D26.

 41. Click the Increase Decimal button on the ribbon (Home tab>Number group). The 
values have five decimal places added. Click the button once more to increase 
the number of decimal places to six.

 42. What are the values displayed in cells D21 and 
D26?

 _________________________________________________

Setting Column Width
 43. Right-click on the column heading for column 

D, and click Column Width… in the shortcut 
menu, as shown in Figure 3-2.

 44. In the Column Width dialog box that is 
displayed, click in the Column width: text box, 
enter 8, and click the OK button to change the 
width of all cells in the column.

 45. What is the value displayed in cell D26? 
Speculate what this means.

 _________________________________________________

 _________________________________________________

 _________________________________________________

 46. Select the range E4:H5.

 47. Click the Decrease Decimal button on the 
ribbon (Home tab>Number group). The values 
have one decimal place removed. Continue 
clicking the button until all decimal places are 
removed.

Accounting 

Number Format

TIP
The drop-down 
list at the top of the 
Number group on 
the Home tab of the 
ribbon can also be 
used to set the data 
type.

Percent Style

Increase 

Decimal

Decrease Decimal

Right-click
Select to change

the column width

Figure 3-2.

Setting the column width.
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 48. What value is displayed in cell G5?

 _________________________________________________

 49. Applying what you have learned, select 
column A.

 50. Click the Font Size drop-down arrow on the 
ribbon (Home tab>Font group), and click 14 in 
the drop-down menu. All cells in column A are 
formatted with a font size of 14 points.

 51. Move the cursor between the column A and 
column B headings. The cursor changes to a 
vertical bar with opposing arrows, as shown in 
Figure 3-3. This indicates the column width of 
the left-hand column can be changed.

 52. Click, hold, and drag to the right until column A is as wide as the word 
Wednesday.

Adding Borders to Cells and Merging Cells
 53. Select columns A through D by clicking the column A header, holding, and 

dragging to the column D header.

 54. Click the drop-down arrow next to the Bottom Border button on the ribbon 
(Home tab>Font group), and click All Borders in the drop-down menu. A thin 
black border is placed around each cell. Note that the button changes from 
Bottom Border to All Borders.

 55. Select the range A1:H1.

 56. Click the Merge & Center button on the ribbon (Home tab>Alignment group). The 
cells are combined into a single cell, and the cell content is centered.

 57. Applying what you have learned, change the font size of the merged cell to 20 
and make the font Times New Roman bold.

 58. Applying what you have learned, change the border of the merged cell to the 
Thick Outside Border style.

 59. Select the range A3:H3.

 60. Click the drop-down arrow next to the Fill Color button on the ribbon (Home 
tab>Font group), and click the red color swatch in the drop-down menu. The 
selected cells are filled in the color.

 61. Applying what you have learned, change the fill color of cell A1 to blue and the 
font color to white.

 62. Applying what you have learned, change the border for cell F5 to the Bottom 
Double Border style.

Entering Formulas
 63. In cell F6, enter an equals sign (=), but do not press the [Enter] key so the cell 

remains active. In Excel, all formulas must begin with an equals sign.

 64. Click cell F4. Notice that F4 is added to the formula being created in cell F6, as 
shown in Figure 3-4. The value in cell F4 will be used in the formula. This is 
similar to using a variable in an algebraic equation. Cell F4 is also highlighted 

Bottom Border

Merge & Center

TIP
When the Font 
drop-down menu 
is displayed, you 
can press the key 
of the first letter in 
the font name and 
the list will jump to 
that letter.

Fill Color

Click and drag 
to change the 
column width

Figure 3-3.

The column width can be changed by dragging the 
column border.
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with a rectangular marquee having corner handles in the same color as F4 
appears in the formula in cell F6. Cell F6 remains active for more to be built onto 
the formula.

 65. Add an addition sign (+) to the formula.

 66. Click cell F5. A reference to this cell is added 
after the addition sign in the formula. Notice 
that this reference is in a different color. 

 67. Click the Enter button (check mark) in the 
Formula Bar or press the [Enter] key to complete 
the formula.

 68. Select cell F6. What is the complete formula that 
was created?

 _________________________________________________

 _________________________________________________

 69. What is the value displayed in cell F6 (not the 
formula), and is it the correct solution for the 
formula? Speculate why the addition error 
exists.

 _________________________________________________

 _________________________________________________

 _________________________________________________

 _________________________________________________

 70. Applying what you have learned, increase the number of decimal places in the 
range F4:F6 to two. Notice that the displayed result of the formula in cell F6 is 
now more accurate, but still not completely correct.

 71. Select cell B27.

 72. Click the AutoSum button on the ribbon (Home tab>Editing group). Notice that 
Excel automatically creates the formula based on the range B4:B26, as shown in 
Figure 3-5. This is because those cells are located directly above cell B27 and 
contain data that can be added.

 73. Click the Enter button in the Formula Bar or press the [Enter] key to accept the 
formula.

 74. Applying what you have learned, change the 
border of cell B26 to the Bottom Double Border 
style.

 75. Select column D, and click the Center button 
on the ribbon (Home tab>Alignment group). 
All cells in the column are set to display data 
centered within each cell. Adjust the column 
width if needed to display the cell contents.

Sorting Data
 76. Select all of the cells in column A that contain 

days of the week.

AutoSum

Center

Formula
being created

Cell is referenced
in the formula

Figure 3-4.

Referring to other cells within a formula is a powerful 
feature of Excel.

Formula is
automatically

created

Help text shows the required
format for the formula

Figure 3-5.

In some cases, Excel will automatically complete a 
formula based on data in adjacent cells.
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 77. Click the Sort & Filter button on the ribbon (Home tab>Editing group), and click 
Sort A to Z in the drop-down menu. This is called ascending order.

 78. A dialog box appears warning that data are present next to the selected range. 
Click the Continue with the current selection radio button, and then click the 
Sort button to sort the data.

 79. What value is displayed in cell A4?

 ___________________________________________________________________________________

 80. Applying what you have learned, sort the days of the week from Z to A. This is 
called descending order.

 81. What value is displayed in cell A4?

 ___________________________________________________________________________________

Working with Various Views
 82. Click the Freeze Panes button on the ribbon (View tab>Window group), and click 

Freeze First Column in the drop-down menu.

 83. Use the scroll bar at the bottom of the screen to scroll to the right. Notice that 
the first column is frozen in place and remains visible. Every column from B on 
can be scrolled out of view.

 84. Select cell C14.

 85. Click the Split button on the ribbon (View tab>Window group). The view is 
split into four panes at that location, as shown in Figure 3-6. Each pane can 
be zoomed and scrolled independent of the others. Note: if this does not work 
correctly the first time, click the button two more times.

 86. Click the Split button to return to a single pane.

 87. Click the Zoom button on the ribbon (View tab>Zoom group).

 88. In the Zoom dialog box, click the 25% radio button, and click the OK button to 
change the zoom level.

 89. Click the Custom Views button on the ribbon (View tab>Workbook Views group). 
The Custom Views dialog box is displayed, as shown in Figure 3-7.

 90. Click the Add… button in the dialog box. The Add View dialog box is displayed.

 91. In the Add View dialog box, click in the Name: text box, enter Tiny, and click the 
OK button.

 92. Applying what you have learned, change the zoom level to 100%.

 93. Applying what you have learned, display the Custom Views dialog box.

 94. Select the custom view in the dialog box, and click the Show button. The view is 
immediately restored.

 95. Set the zoom level to 100%.

Sort & Filter

Freeze Panes

Split

TIP
Removing the 
split screen also 
unfreezes any rows 
or columns.

Zoom

Custom Views
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View is split into four panes

Figure 3-6.

Excel allows the view of a worksheet to be split.

Click to restore
the selected view

Saved
custom view

Click to name
a new custom view

Figure 3-7.

Custom views can be saved and later restored.
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Inserting and Deleting Columns and Rows
 96. Applying what you have learned, select column C.

 97. Click the drop-down arrow below the Insert button on the ribbon (Home 
tab>Cells group), and click Insert Cells in the drop-down menu. Since an entire 
column is selected, a new column is inserted to the left of the selected column. 
The data in the selected column are moved to the right to make room for the 
new column.

 98. Applying what you have learned, create a series beginning in cell C4 (in the 
inserted column) with 25 and ending with 575 in increments of 25. In other 
words, 25 will be added to the number in the cell above. Notice how the 
numbers are automatically formatted in accounting format. The formatting of 
the inserted column is inherited from the column to the left of where it was 
inserted.

 99. Applying what you have learned, select row 2.

 100. Right-click on the row header or anywhere in the selected row, and click Delete 
in the shortcut menu. Row 2 is completely removed from the worksheet. Notice 
how rows and columns can be inserted or deleted using the command buttons 
on the Home tab of the ribbon or by using the shortcut menu.

Printing a Workbook
 101. Click the File tab in the ribbon.

 102. Click Print in the backstage view. The print backstage view is displayed.

 103. On the right of the print backstage view, click the top drop-down list under 
Settings, and click Print Active Sheets in the list. This prints only the active 
worksheets.

 104. Click the bottom drop-down list under Settings, and click Fit Sheet on One 

Page in the list. This will shrink the size of everything if needed in order to fit 
on a single page.

 105. With your instructor’s permission, click the Print button to print the worksheet.

Customizing the Quick Access Toolbar
The Quick Access toolbar, which is often abbreviated QAT, can be customized. Since 
it is always visible regardless of which ribbon tab is displayed, placing commands 
you frequently use on this toolbar can increase your efficiency.

 106. Click the Customize Quick Access Toolbar button on the Quick Access toolbar. 
A drop-down menu is displayed, as shown in Figure 3-8.

 107. Click Print Preview and Print in the drop-down menu to check it. Buttons that 
are shown on the toolbar are checked in this menu. Showing the Print Preview 

and Print button on the Quick Access toolbar makes it easier to access print 
commands.

 108. Click the Save button on the Quick Access toolbar to save your work.

Insert

TIP
If an entire 
column is selected, 
the Insert Cells 
command has 
the same effect 
as the Insert 

Sheet Columns 
command. If only 
a single cell or a 
range of cells is 
selected, the Insert 

Cells… command 
in the drop-down 
menu (not the 
button itself) opens 
a dialog box in 
which you must 
specify how the 
data are shifted.

Customize Quick

Access Toolbar

TIP
Customizations 
to the Quick 

Access toolbar are 
saved in the Excel 
settings, not in the 
document, so they 
will be in place for 
all documents.
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 109. Click the Print Preview and Print button on the Quick Access toolbar. The print 
backstage view is displayed.

 110. Explore the options in the print backstage view, and then change the orientation 
to landscape orientation. Notice that the print preview now displays the page 
with the longest side of the paper at the top.

 111. Applying what you have learned, set the worksheet to be scaled to fit on one 
page.

 112. With your teacher’s permission, print the worksheet.

 113. Save your work, and close Excel.

Print Preview 

and Print

Click to add this
item to the toolbar

Checked items
are on the toolbar

Click

Figure 3-8.

Customizing the Quick Access toolbar.
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Answers

Lesson 1
Activity 1-1

 1. Home

 2. Data

 3. Review

 4. Formulas

 5. Page Layout

 6. Insert

 7. Review

 8. View

 9. Page Layout

 10. Home

 11. File

 12. View

 13. Home

 14. Insert

 15. Review

 16. Data

 17. Insert

 18. View

 19. Formulas

 20. Review

 21. Insert

 22. View

 23. Home

 24. Page Layout

 25. Insert

 26. Home

 27. Insert (or Home)

 28. Data

 29. Page Layout

 30. Review

 31. File

 32. Insert

 33. Insert

 34. Review

 35. File

 36. Home

 37. File

 38. Insert

 39. Review

 40. Home

 41. Insert

 42. Page Layout

 43. Home

 44. File

 45. Formulas

 46. Review

 47. Home

 48. Page Layout

 49. Review

 50. Insert

Activity 1-2

 1. Paste; inserts the contents of the clipboard

 2. Cut; removes the selected content and places it on the clipboard

 3. Save; saves the document

 4. Copy; copies the selected content to the clipboard

 5. Format Painter; copies the formatting of one selection to another selection

 6. Bold; makes selected text boldface

 7. Orientation; rotates text in a cell

 8. Clear; deletes everything in the selected cell

 9. Font Color; changes the color of selected text

 10. Insert Cells (or Insert); inserts a cell and shifts other cells downward

 11. Increase Decimal; shows a more precise value

 12. Fill Color; places shading in the cell

 13. Accounting Number Format; assigns a currency format to the selected cell

 14. Decrease Indent; decreases the indentation of the selected paragraph

 15. Align Right; right justifies the selected cell
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 16. Insert Equation (or Equation); inserts a common mathematical equation or allows construction of an 
equation

 17. Win/Loss (or Win/Loss Sparkline); inserts a win/loss line chart within a single cell

 18. Print Area; marks what part of the sheet will print

 19. Find & Select; finds text in the document

 20. Align Objects (or Align); aligns the edges of selected objects

 21. Math & Trig; displays a drop-down menu that allows the insertion of a mathematical or 
trigonometric function

 22. Name Manager; displays a dialog box for managing named cells and ranges

 23. Bottom Border; adds a rule (line) below the selected paragraph

 24. Add a Hyperlink (or Hyperlink); creates a hyperlink to a web page, document, or location within the 
current document

 25. Insert a SmartArt Graphic; inserts decorative graphical information

 26. Spelling; begins a spell-check of the document

 27. Thesaurus; suggests similar words to the selected word

 28. Zoom; allows reduction or enlargement of the view of the document

 29. Error Checking; checks for common errors in formulas

 30. Close; closes the current document

 31. Undo; reverses the last action

 32. Redo; reinstates an undone action

 33. New Query; discover, connect, and combine data from multiple sources

 34. Refresh All; updates all information coming from a data source

 35. Symbol; displays a drop-down menu that allows insertion of a symbol

 36. PivotChart; inserts a pivot chart to graphically summarize data

 37. Table; creates a table

 38. Sort & Filter; enables filtering of selected cells

 39. Online Pictures; displays the Insert Pictures dialog box for adding illustrations, photographs, and 
sounds to the document

 40. Change Page Orientation (or Orientation); displays a drop-down menu for setting the page 
orientation

 41. Remove Duplicates; deletes duplicate rows from the sheet

 42. Theme Effects (or Effects); displays a drop-down menu for setting the theme of the document

 43. Consolidate; combines values from multiple ranges into a single range

 44. Subtotal; totals several rows of data

 45. Share Workbook; allows multiple users to simultaneously work in the workbook

 46. Zoom to Selection; zooms so the selected cells fill the window

 47. Insert Function; opens a dialog box for selecting a function to insert into the current cell

 48. Background; allows a picture to be added as a background to the worksheet

 49. Shapes; displays a drop-down menu for inserting premade shapes such as lines and arrows

 50. Merge & Center; combines the selected cells into a single, larger cell and centers the content
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Lesson 3
 16. The days of the week are listed in order, beginning with Monday.

 19. 20

 22. 55

 23. C23

 24. Values increase by five.

 27. 1001

 30. 30.66667

 33. 157.6667

 36. $12.00

 39. 10500%

 42. D21 is 776.000000 and D26 is 1001.000000

 45. A series of pound signs (#) are displayed; this means the value is too wide to be displayed in the cell 
with the current column width.

 48. 131

 68. =F4+F5

 69. The value displayed is 124, when it should be 125. This is due to a rounding error.

 79. Friday

 81. Wednesday

Lesson 4
 51. seven

Lesson 5
Note: table numbers may differ depending on how the tables were constructed.

 29. =SUM(Table2[@[Roses]:[Daisies]])

 30. =SUBTOTAL(109,[Total])

 37. =COUNTIF(Table2[Grade Level],9) and there are six students in ninth grade

 39. 17

 56. =IF([@Roses]>=[@Daisies],“Roses”,“Daisies”)

 100. =MAX(Table2[[Roses]:[Daisies]])

 102. =COUNTIF(Table2[Carnations],“>0”)

 113. =$E$12*(2+$F$19)/7 (cell references may be different depending on how the table is sorted)


